Extended PO Receipt Entry SmartFinder — Receipts

Extended PO Receipt Entry

Extended PO Receipt Entry is an enhanced replacement for the Sage P/O Receipt Entry form. It provides
you with more information while entering a receipt and fast access to additional PO, Vendor, and Item
information.

The following pictures show some of the extra features on the Extended PO Receipt Entry screen:
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Click the following links for details on each Extended PO Receipt Entry feature:

SmartFinder — Receipts Finds purchase orders and shows PO details quickly for any vendor.
SmartFinder — Vendors Find a vendor quickly from a name, description, phone number or an
address.

SmartFinder — Purchase Orders Finds purchase orders and shows PO details quickly for any vendor.
SmartFinder — Items Find an item quickly from partial item number or description. Search also by
manufacturer’s item number with the Enterprise version of Productivity Tools.

SmartFinders provide fast, browser-like search capabilities for looking up data on the PO Receipt
Entry screen. They search more fields than the Finder, and search in all text fields at once. For
example, search for “Seattle” if you think that the vendor or contact is in Seattle.

Vendor Inquiry (button left of the vendor name field) provides complete vendor data, including POs,
receipts, purchases, requisitions, invoices, payments, adjustments, etc.

Vendor Optional Fields Display any vendor optional fields on the Extended PO Receipt Entry screen.
Require PO Number Optionally require purchase order numbers on receipts for all or selected
vendors.

Quantities Display Show item quantities at the bottom of the standard PO entry window - the same
item quantities that are displayed in the Sage 300 Order Entry module.

Item Quantities at Other Locations Display quantities available at other locations or in other
companies while entering a purchase order.

Drop Ship Drop ship dozens of purchase order detail lines in a single operation.

Receive in Sorted Order (Receive button) Receive items by item Number or several other selectable
orders.

Quick PJC Entry Default newly inserted lines to have the same Contract, Project and Category
selections as the previously entered line.
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Extended PO Receipt Entry SmartFinder — Receipts

SmartFinder — Receipts

Click the Receipt Number button at the top of the screen to open the SmartFinder. _

e Enter one or more words or word fragments in the entry field to search multiple tables and fields,
and then click the Find button.

e Search returns records which contain the search string in any of the searched fields.

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see an invoice where “Ross” is in the Vendor
Name field and “Blvd” is in the Address 1 field.)
o Addresses (e.g. the vendor address) are treated as a single field.
Display:
e The top grid displays the receipts matching the search criteria. Double-click to select an receipt.
e The bottom grid displays the item details of the receipt highlighted in the top grid.

e Click the Address 1 column heading or double-click the address to launch Google Maps with the
vendor address. You can also check the locations of Ship-To and Bill-To addresses.

e Double-click email addresses (such as the Contact E-mail) to create new emails.

%/ PTDEMO - Extended PO Receipt Entry (=N
Eile Help
Search hat I Find ]
Receipt Number Purchase Order ... | Invoice Number 2 e = Address 1 Address 2
RCPO00000T1 g 3718 Colorado
RCPO00D0023 HBE-993 1540 Hart Batteries 3718 Colorada
RCPO00D0030 IN154114 1540 Hart Batteries 3719 Colorada
RCPO00D0046 IN154124 1540 Hart Batteries 3713 Colorada
RCPOODD0063 IN154134 1540 Hart Batteries 3715 Colorado

ltem Number ltem Description Location Ordered Guantit Unit of Measure Wendor ftem Nu Order Number Manufacturer’

A1-103/0 Fluorescert Des... 4 300 Ea.
C1-500/B High Back Am 4 48 Ea
51-200/B Fat Screen 56 ... 4 75 Ea.
4 1 | 3
Selec
Selection:
e Double-click a receipt in the top grid to select the receipt and display the receipt details on the
screen.
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Extended PO Receipt Entry SmartFinder — Vendors

SmartFinder — Vendors

Click the Vendor Number button to open the SmartFinder for searching vendors. | Vender Number

Search:

Enter one or more words or word fragments in the entry field to search multiple tables and fields.
You can also filter for Active vendors.

Search returns vendors and remit-to location records which contain the search string in any of the
searched fields — for example, one record may have “Royal” in the name, where another may
have it in the address field. Both records will be displayed.

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a vendor where “Ross” is in the Vendor
Name field and “Blvd” is in the Address 1 field.)

o Addresses (e.g. the vendor address) are treated as a single field.

Display:

The top grid displays the vendors matching the search criteria.
The bottom grid displays the remit-to locations that match the search criteria.

Note that the remit-to locations may not be related to the vendor records displayed in the top part
of the screen. The screen below displays remit-to locations for two different vendors.

Click the Address 1 column heading or double-click the address to launch Google Maps with the
vendor address. You can also check the locations of Ship-To and Bill-To addresses.

Double-click email addresses (such as the Contact E-mail) to create new emails.

= PTDEMO - Extended PO Receipt Entry o O |
Eile  Help
Saarch Jsnamie [ Find

[3 Address Lin | Address Line 2

Ackive Fiemit-Ta Locations Only

| PoBox 13233
| PO Box 13790

Selection:

Double-click a vendor in the top grid to select and enter the vendor on the receipt.

Double-click a remit-to location in the bottom grid to add the vendor and this remit-to address to
the receipt.
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Extended PO Receipt Entry SmartFinder — Purchase Orders

SmartFinder — Purchase Orders

Click the PO Number button to open the SmartFinder for searching purchase orders. | FO Number

Search:

e Enter one or more words or word fragments in the entry field to search multiple tables and fields,
and click the Find button. (Note that you must entry a criterion — such as “a” — to search.)

e You can filter by purchase order type and include completed and on-hold purchase orders.

e Search returns records which contain the search string in any of the searched fields — for
example, one record may have “Royal” in the name, where another may have it in the address
field. Both will be displayed.

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a PO where “Ross” is in the Vendor Name
field and “Blvd” is in the Address 1 field.)

o Addresses (e.g. the vendor address) are treated as a single field.

Display:

e The top grid displays the POs for the vendor that match the search criteria. Double-click to select
a PO.

e The bottom grid displays the details of the purchase order highlighted in the top grid.

e Click the Address 1 column heading or double-click the address to launch Google Maps with the
vendor address. You can also check the locations of Ship-To and Bill-To addresses.

e Double-click email addresses (such as the Contact E-mail) to create new emails.

% PTDEMO - Extended PO Receipt Entry (=N EEw =]
File Help

Search feon I Fnd ]
Purchase Order Type Al + [l Includs Completed Purchase Orders [ Jinclude Purchase Orders on Hold

Active
PO000000008 Active 4540 Leon Industries 347 Central Far
PO00000000S Acti 4540 Leon Industries 342 Central Park
POO000000010 Acti 4540 Leon Industries 342 Central Park

A1-400/0 Desk Note Book 1 200 Ea 141372019
A1-401/0 Desk Calendar Pad 1 200 Ea 1/13/2019
A1-450/0 Bulletin Boand 1 200 Ea 11372019
A1-470/0 Dry-erase White Board Markers 1 200 Ea 11372019
A1-650/0 Highlighter 1 500 Ez. 11372019
A1-655/0 Pen 1 500 Ez. 11372019
4 it *
B
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Extended PO Receipt Entry SmartFinder — Items

SmartFinder — Items

Click the Item Finder button under the item grid to open the SmartFinder for items.

The Item Finder provides several item search options and displays search results in a selection grid with
columns such as description, alternate item number, stock item flag, or sellable flag. You can select which
columns are displayed and searched.

File Help

Manufacturer’s fem Number
Find ftems By
[ Search ~] |

Location 2 | [Portand Offce |
[ Active ttems Orly

[5 em Number | Desciption Status | Comment 1 Structure Code | Category

e The ltem Finder appears with the “Search” selected by default on the Items tab. This is the most
common way to look up items.

o Type a partial item description or item number in the text field, optionally select Active Items
Only, and press Enter to immediately search for items.

o Alternatively, select a different “Find Items By” choice from the Find Iltems By dropdown. For
example, you can choose “Show All Records” and specify a range of item numbers, structure
codes, categories, or account sets using the range fields. You can specify more selection fields
using Additional Criteria.

File Help
ltems  Manufacturer's ltem Number
Find tems By
[ Show All Recards ~]
ftem Range
Select tems By From To
[ hem Number | [A105/ |3 [piom |2
[(Nare) -]
[ (Nre) -]
[ (Nre) -]
Additional Criteria. . Reset Defaults
Location B | [Porland Office
Notes:

e The above search screen displays two tabs for looking up inventory items — Items and
Manufacturer’s Item Number — which let you search for I/C item numbers or for manufacturer’s
item numbers.

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.

The Manufacturer’s Item Number tab will not appear unless you have a license for the Enterprise
version of Productivity Tools.
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Extended PO Receipt Entry SmartFinder — Items

Searc

The lte

If you do not select the SmartFinder “Search” option, you can select up to four item field ranges —
by item number, status, structure code, category code, and account set code.

The item price is the quantity zero price for that customer.

The Item Finder also displays all columns that are in the standard Sage Finder. You can choose
which columns appear in the Item Finder by selecting File > Settings from the Item Finder menu.

Selecting an item inserts a new row into the PO entry grid.

hing for Inventory Control Item Numbers on the Items Tab

m Finder on the Items tab provides 7 search options:

File

Help

ftems
Find

Manufacturer's kem Number
ltems By

Search ][ |

tem

TaiRox

Show Al Records

Description
[ Structure Code

HNumber |Pnrtland Offics \

Category
Accourt Set Code Status Comment 1 Structure Code
Search

Search (most common option) — to search for words or word fragments in item text fields (such
as the item number, item description, structure code, category, price list, picking sequence, and
comments). This search works like the PO Number and Vendor Number SmartFinders.

Show All Records — to select items from all item records based on ranges of Iltem Number,
Structure Code, Category, and Account Set Code and on item Status. You can also specify
additional selection criteria to use more item fields.

Iltem Number — to select items using part of the item number. You can refine your selection
based on ranges of Item Number, Structure Code, Category, and Account Set Code, select items
by item status, and specify additional selection criteria using more item fields.

File Help

tems  Manufacturer’s fem Number
Find fems By

[ hem Number | [ Starts with [ |
Starts with
tem Range

Search by Item Number, Description, Structure Code, Category and Account Set Code also let
you specify a search value that the item starts with or contains.

Note that the “Search” choice automatically looks all displayed fields.

Description — to select items that begin with or contain a string of characters. You can refine
your selection based on ranges of Item Number, Structure Code, Category, and Account Set
Code, select items by item status, and specify additional selection criteria using more item fields.

Structure Code — to select items with structure codes that begin with or contain a string of
characters. You can refine your selection based on ranges of Item Number, Structure Code,
Category, and Account Set Code, select items by item status, and specify additional selection
criteria using more item fields.

Category — to select items in categories that begin with or contain a string of characters. You can
refine your selection based on ranges of Item Number, Structure Code, Category, and Account
Set Code, select items by status, and specify additional selection criteria using more item fields.

Account Set Code — to select items with codes that begin with or contain a string of characters.
You can refine your selection based on ranges of Item Number, Structure Code, Category, and
Account Set Code, select items by item status, and specify additional selection criteria using
more item fields.
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Extended PO Receipt Entry SmartFinder — Items

More on the “Search” option (most common option):

File Help

tems  Manufacturer's kem Number
Find ltems By
-1 \

Location [ | [Portand Cffice |

[ Active tems Only

e Select Find Items by Search. (Note that Find Items By defaults to the last choice used.)

e Enter one or more words or word fragments in the next field to search multiple item tables and
fields. (Note that the program scans all columns displayed by the Item Finder.)

e You can filter for Active items only.

e Search returns items and vendor item numbers that contain the search string in any of the
searched fields — for example, one record may have “Desk” in the Description field, where
another may have it in the Comment 1 field. Both items will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300
Main Street" as well as "123 Main Street, Suite 300".

o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".

Note:

o If using the Search option, all of the word fragments must be present in one of the fields that
are displayed on the screen. (For example, if you search for “desk lamp”, you will not see an
item where only “desk” is in the Description field and only “lamp” is in the Comment 1 field.)

Display:

e The top grid displays the items matching the search criteria. The screen below shows “Desk
Lamp” in the description of one item, and “Desk Lamp” in the comments of the second one — so
both appeared.

e The bottom grid displays any entered vendor item numbers for the item selected in the top grid.

File Help

ftems Manufacturer's fem Number
Find hems By
[ searen ~| [pesklam |

Location 3 | [Portiand Gfiice I

us | Comment 1

ive | Comes with stand and mouniing bracket forwallor... | 5 e
A1310/0 Halogen Desk Light Active  Desk lamp wih adjustable reflector and am. STD A1 Ves

< 2|

Vendor tem Numbers

Selection:
o Double-click an item in the top grid to select and enter the vendor on the purchase order.
e Double-click a vendor item number to enter the item number and the vendor item number into the
PO form.
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Extended PO Receipt Entry

SmartFinder — Items

Selecting columns to display — and scan —in the Item Finder

Choose File > Settings in the Item Finder window to change column settings.

File Help

Close

Settings...

Reset Defaults
[TActive tems Orly

~ Up
] Atemate tem Set Number Manufacturer's ltem Number

Description Manwfacturer's tem Description

Date Last Maintained SEZL Qty. Avaiable Down)
Status Qty. Available (Al)

Structure Code Al Manufacturer Number

Category Preferred Vendor tem

Accourt Set Code < None Prefened Vendar

Stock ftem

Stocking Unit of Measure

Defautt Price List Code

Unit Weight

Defautt Picking Sequence

Serial Numbers

Commodity Number

Date Inactive

Segmert 1

Segmert 2 v
|Tha maximum number of columns is 50, selected is 8 ‘ oK Cancel

e The current columns that are displayed appear in the right-hand column.

¢ Highlight columns that you want to add in the left-hand column and click the Include button.

Note:

e Settings apply to the currently selected tab. For example, if you want to change the columns
on the Manufacturer’s Item Number tab, choose the tab first, and then select File > Settings.

e Only the “Included Fields” are used for searching. For example, if you do not include the

Comments 1 field, the program will not scan the comments. Also note, that the number of fields
will affect performance. If search is slow, remove columns that you don’t need.

All of the possible columns are shown below. Note that optional and calculated fields are also available
for inclusion — for example Item’s Color and Qty. Available for Sale.

ke Nurber

~
Altemate tem Set Number
Description

Date Last Maintained

Status

Structure Code

Category

Accourt Set Code

Stock ftem

Stocking Unit of Measure
Defautt Price List Code

Unit Weight

Default Picking Sequence
Serial Numbers

Commodity Number

Date Inactive

Segment 1

Segment 2 A

<- Exclude

Al =

<- None

Manufacturer’s ftem Number
Manufacturer's kem Description
Gty. Available

Gty. Available (All)
Manufacturer Number
Prefemed Vendor ftem

Prefemed Vendor

The maximum number of columns is 50, selected is 8

OK

Cancel

Up

Down

ls tem a BOM Component
Serial Number Mask

MNext Serial Number

Use Serials Days to Expire ™

Allow Different Lot Gty

Lots Optional Fields

Default Lot Wamanty Code
Default Lot Contract Code ™

Lot Mask Description
Unformatted Lot Number

Lot Number

Auto-gen Lot Number e

ltem’s Color

Dangerous ftem

BExtended Wamanty Available
tem Type e

Gty. On Purchase Order (All)
Gty. On Sales Order (All)
Stocking Unit of Measure
Gty. Committed

« ]

Comment 2 - Serials Days to Bxpire - Lot is on Cont. When Recein Mumber of Lots to Generate .« ltem Lead Time - Gty. Committed (All} -
Comment 3 Allow Different Seral Gty Lot is on Warr. When Sold Mumber of Lots not Generate Manufacturer Gty. Available for Sale
Comment 4 Serials Optional Fields Serial Numbers in Use First Generated Lot Manufacturer Number Gy, Available for Sale (All}
Allow tem in Web Store i Default Seral Wamranty Code Serial Mask Structure Last Generated Lot MNew ftem Base Price (CAD)

Kitting tem |= | Default Serial Contract Code Serial Mask Description SIA Prefemed Vendor Type Price Pricing Unit

Optional Fields - Serial is on Cont. When Rec Unformatted Serial Mumber Default BOM Number ltem Procurement

Default Kit Number Serial is on Warr. When Solc— Serial Number Seasonal? ltem Size

Weight Unit of Measure Serial is on Warmr. When Reg E| Auto-gen Serial Number Gty. on Hand ltem Valume

Unformatted Atemate kem P Lot Mumber Mask Mumber of Serials to Genera — Gty. on Purchase Order Warmrarty

Altemate ftem Number Mext Lot Mumber Number of Serials not Gener| = Gty. on Sales Order Waranty Period

Altemate ftem Description Use Lots Days to Expire First Generated Serial Cty. Available Gty. On Hand

Costing Method Lots Days to Expire Last Generated Serial Gty. Committed ] Gty. On Purchase Order

Process Command Use Lots Days on Quarantin Lot Mumbers in Use Prefemed Vendor |= | Gty. On Sales Order

Weight Conversion Factor Lots Days on Quarartine Lot Mask Structure Prefemed Vendor kem B Gty. On Hand (All)
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Extended PO Receipt Entry SmartFinder — Items

Searching for Iltems on the Manufacturer’s ltem Numbers Tab

Note: The Manufacturer’'s ltem Number tab will not appear unless you have a license for the Enterprise
version of Productivity Tools.

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.

Eile Help

kems Manufacturers tem Number
Find kems By
Search |v |

Manufacturer’s kem Number
Manufacturer's kem Description
Search

[E tem Mumber | [B] Manufacturer's tem Number | Manufacturer's tem Description | Gty. Available | [B Qty. Available (All) | Manufacturer N...

e The Manufacturer’s Item Number Finder appears with “Search” selected by default. This is the
most common way to look up items by manufacturer’s item numbers.

o Type a partial item description or item number in the text field, optionally select Active Items
Only, and press Enter to immediately search for manufacturer’s item numbers.

o Alternatively, select “Manufacturer’s ltem Number” or “Manufacturer’s Item Description” for
searching.
The Item Finder on the Manufacturer’s ltem Number tab provides 3 search options:

e Search (most common option) — to search for words or word fragments in manufacturer’s item
text fields (the manufacturer’s item number or the manufacturer’s item description).

This search works like the PO Number and Vendor Number SmartFinders.

¢ Manufacturer’s Item Number — to select items using part of the manufacturer’s item number.

File Help

ftems  Manufacturer’s hem Nomber
Find fems By

[ Manufacturer's fem Number | [ starts with [
Starts with
[ Active ems Oniy

You can specify that the item number starts with or contains the string that you enter.

¢ Manufacturer’s Item Description — to select items using part of the manufacturer’s item
description. As with the item number, you can specify that the item description starts with or
contains the string that you enter.

Note that the “Search” choice automatically looks in the manufacturer’s item number and the
manufacturer’s item description fields.

TaiRox Productivity Tools for Sage 300 9
© 2009-2024 TaiRox Software Inc. All rights reserved.



Extended PO Receipt Entry Vendor Inquiry

Vendor Inquiry

Vendor Inquiry button displays the TaiRox Productivity Tools Vendor Inquiry screen — a convenient way to
view data related to the vendor. Each tab focuses on an aspect of the vendor’s data.

You can also look up details for other vendors while you are on this screen.

4« b M Q4+ T T

Vendor Number |15®D | ! D_ @ |G|E|rrt Office Supplies

PTDEMO - Vendor Inquiry - =]

File Settings Help

VendorNo. | |4 o [ |

X
Q | |Gmnt Cffice Supplies ‘ .Vendor Cumency l:l

Pending Requistions POs PO Receipts PO Invoices PO Retums POCR/DR  Purchases Aging hems
Profile  Address Comments Optional Fids. Remit-To Recur. Payables Activity Documents Payments  Adjustments

Short Name GRANT Start Date 05/09/1995
Legal Name | ‘ Last Maintained  |08/18/2010
Group Code |\NV ‘ |Inventory Purchases ‘ Active /A

Account Set |us.\ \ |)\ccuurrls payable, Other ‘ On Hold

Rate Type

Bank Code |SE‘\T&C ‘ |Seaﬂ|e Tacoma Bank ‘
Paymert Cods |CHECKUSD \ |USD check Seattle Tacoma Bank ‘
Check Language l:l

Delivery Method

Tee DUETBL Due by Invoice Date \

Retainage Terms

Retertion Perod
Tax Group |CALIF \ |Ca|iforrna State Tax Group \
Tazx Authority Authority Descri... TaxClass | Class Description Registration Number Tax Included
STATE State Tax 1 Taxable tem No
COUNTY Courty Tax 1 Taxable merchandise No
Vendor Account Status
Outstanding Balance 1.123.641.50 No. of Open Invoices l:l

Prepayment Amourt

No. of Prepayments Ijl

Outstanding Retainage

Credit Limit 1,000.00
Befresh
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Extended PO Receipt Entry Vendor Optional Fields

Vendor Optional Fields

If you use the Sage 300 Optional Fields module, you can display any optional fields from the A/P vendor
record on the right side of the Extended PO Receipt Entry screen.

SAMLTD - Extended PO Receipt Entry

File Help  P/O Receipt Entry

Receipt Number| |4 4 |RCPO000000 > Qo+ Entersd By P

Receipt Taxes Additional Costs Optional Fields Rates  Totals

PO Numbes PO000000DOT From Muttiple POs Job Related Retainage Ma. of Receipts 1 Optional Field | Value
R 0150108 T o 20750109 2m8-0 Last Receipt No, | RCPODDDD0DT | Require PO Number on Receipts |
S osting Bete S Mote Note that wendor bills thro
Template l:l Bill-To Location 0_ Ship-To Location D_ Vendor's Purchasing Represen... Veena Strong
Vendor Class Service Provider
FOB Point | ‘ Ship\ia |GFS | |G\uba| Freight Service

This feature lets you view notes concerning the account during data entry, and also view receipt
requirements — in this example, one of the fields is “Require PO Number on Receipts.”

You specify which optional fields to display on the Extended PO Receipt Entry screen using the
Productivity Tools Options program.

Require Purchase Order Number on Receipts

Extended PO Receipt Entry includes an option to require users to include purchase order numbers on
receipts for all or for selected vendors. You select this option in the Productivity Tools Options program.

SAMLTD - Extended PO Receipt Entry

File  Help P/Q Receipt Entry

Receipt Number| |4 4 QO+ Entered By l:l * Required

Receipt Tages Additonal Costs Optional Fields Rates Totals

I PO Number | ' I ] From Muttiple POs 0_ []Job Related Retainage Mo. of Receipts DI Optional Figld
Receipt Date 20210413 Posting Date 20210419 2021-04 Last Recsipt No. |
MNote Note that vendor bills thro
Template l:l )} Bill-To Location l:l )] 0_ Ship-To Loeation l:l )] D_ Vendor's Purchasing Represen... Yeena Strong
Vendor Class Service Provider
FOB Point | | Shpia | |4 |

If you use the option to force PO numbers on receipts, but try to post a receipt that's missing the PO
number, the following message appears.

Ermor

Description: Purchase Order Number cannct be blank.

Source: 10:18:08 -

e The program lets you require PO numbers for all vendor receipts, or only for vendors with a “Yes”
value for a specific optional field. For example, the Extended PO Receipt Entry screen pictured
above shows an optional field called “Requires PO Number on Receipts” — where the value “Yes”
for the field determines that a PO number is required.

TaiRox Productivity Tools for Sage 300 11
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Extended PO Receipt Entry Require Purchase Order Number on Receipts

e |f a vendor record does not include a value for the Yes/No optional field, the program will not
require a purchase order number when you create a receipt.

Setting Up the Option to Require PO Numbers on Receipts
In the following example, the program uses the Yes/No value in Optional Field “REQPO” (with a
description “Requires PO Number on Receipts”) to determine whether vendors require a PO number.

e You choose the option and the optional field using the Productivity Tools Options program on the
Sage 300 Desktop:

+ TaiRox Productivity Tools 2 . .
P A e TaiRox Productivity Tools (General Ledger Tools)
CCoERE R Licensed ta: Don Thomson, TAIROX SOFTWARE INC
General Ledger Tools Dealer:

Inventory Contral Tools o

Multi-Company Tools
Order Entry Tools

Purchase Order Tools

General Ledger Tools ~ Order Entry Tools  Purchase Order Tools  Inventory Control  Accounts Receivable
~ Visual Process Flows

Tools Tools
A/P Transactions
A/R Transactions t"l t"J &_"J
CHA o T Accounts Payable  Multi-Company Tools License Information Options Convert Contacts
C/P Transactions Tools
4 Tranca, rtinnc v
SA0E  ForHelp, press F1 ] Session Date: 2021-04-12

SAMLTD - Options

File Help

Menu ftem Quantities Order Entry  Purchase Orders

I Receipt Must Have a Purchase Crder Number Vendor Optional Field REQPO | ‘I

Leave the Vendor Optional Field blank if a Purchase Order Number is required for all vendor receipts. Select a Yes/No Vendor
Optional Field name to control this option by vendors.

Purchase Order/Receipt Vendor Optional Fields To Display

Include > Up
Accounts Payable Contact Type Note

Disc Level Vendor's Purchasing Representative

Discourt Grace Period SE=iE Vendor Class Bgwey
Due Date Grace Period

Temporary Vendor Al ->

UPS Zone

¢ If you use the option to force PO numbers on receipts — and the vendor record includes the
control field with a “Yes” value — the following message appears when you try to post a receipt
that’s missing the PO number.

SAMLTD - Extended PO Receipt Entry

File Help  P/OReceiptEntry

Rl i L R —
s e = |

Receipt Taxes Addtional Costs Optional Fields Rates Totals

PO Number 2

[ From Muttiple POs ) [ Job Related Retainags MNo. of Recsipts

Receipt Date Last Recsipt No. | =
o
Template Eror Ship-To Location l:l = Vendor's Purchasing Represen. . Veena Strong
T i Vendor Class Service Provider
FOB Point lescription: Purchase Order Number cannot be blank :| ) ‘
S Source: 10:27:51- ‘

e Inthis example, the “Requires PO Number . . .” field also appears at the top of the Optional Field
list on the Extended PO Receipt Entry screen.

Note that the field appears on the Extended PO Receipt Entry screen if:

o It has been added to the Vendor record in A/P.
o Itwas added to the set of optional fields that are displayed in Extended PO Receipt Entry
(using the Productivity Tools Options program).

TaiRox Productivity Tools for Sage 300 12
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Extended PO Receipt Entry Quantities Displayed on the PO Receipt Entry screen

Quantities Displayed on the PO Receipt Entry screen

Extended PO Receipt Entry displays item quantities for the selected location and item at the bottom of the
PO Receipt Entry window — like the quantities displayed on the Extended PO Entry screen.

The program also provides drill-down links for quantities on sales order, quantities on purchase order,
and committed quantities.

Note that the screen below shows the single location displayed for the current line item in the grid, as well
as a total for all locations.

You can change the display to include item quantities for multiple locations in multiple companies.

PTDEMO - Extended PO Receipt Entry

Eile  Help  P/O Receipt Entry

[Receipt Number] |4 4 [ NEW™ > M Q+ Entered By
Vendor Mumber 0_ a |G'E""t Office Supplies |
Receipt Taxes Additional Costs Optional Fields Bates  Totals
PO Number | | |Q From Mutiple. POs lobRelted [ |Retainage  No.ofRecapts | 0]
Receipt Date Posting Date |D1»” 10/2020 | |2020-m | Last Receipt No. | |
Template |:| Bill-To Location I:I -\ o_ Ship-To Location I:I -\ o_
FOB Foint | | ShipVia | |2 |
liom=Eadet |DUETBL | Q |D|.|e by Invoice Date |
Vendor Acct. Set * |USA | Q |.ﬂ\ccourrts payable, COther |
Description | Reference |
Q. ttem Number tem Description Q, Location Quartity Received | @ Unit of Measure
1 Mo A1-105/0 13W Mini Fluorescent Bulb 1 No 0 Ea.
[l [T | — S
[ leems Tax... ] [ Calc. Taxes ] Receive Al [ ltem Finder... ] [ Drop Ship.. ] [ Beceive... Receipt Subtotal D-DD| |USD |
[ Post ] [ Invoice... ] [ History... ]
Gty. On Hand  Gty. On Sales Order  Qty. On Purchase Order City. Committed Cty. Available
Location 1 (Ea.) 70 15 [H 80 [ 0 70
All Locations (Ea.) 378 23 [H 480 [4 0 378

Displaying Quantities for multiple locations and companies

Extended PO Receipt Entry can also display item quantities available at other locations — either at the
bottom of the Extended PO Receipt Entry screen or in a separate window.

To display quantities for multiple locations and companies:

e Select the Extended PO Receipt Entry > File > Settings menu choice to change the Item
Quantities display settings.

TaiRox Productivity Tools for Sage 300 13
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Extended PO Receipt Entry Displaying Quantities for multiple locations and companies

Disolav kem Quantites

[ Save ]

%2 PTDEMO - Extended PO Entry Settings

=5

Display on Separate Screen
Do Mot Displa

Digplay on Entry Screen
Display on Separate Screen

-

o Do Not Display — shows only total quantities and quantities for the current line item location.

o Display on Entry Screen — includes a new grid at the bottom of the screen that displays
guantities at all locations, in the current company and any associated companies.
Qty.On Hand  Gty. On Sales Order  Gty. On Purchase Order Qty. Committed Qty. Available
Location (Ea.) (1] 0 [H (1] 0 0
All Locations (Ea.) 657 23 [§ 276 [4 0 657
Database ID Location Description ltem Number Description
SAMINC Sample Compan... 1 Central warehou...  A1-103/40 Fluorescent Des... Ea. 137 [
SAMINC Sample Compan... 2 Portland Office A1-103/0 Fluorescent Des... Ea 262 -
4| 1 | 3
o Display on Separate Screen — displays the item quantities at all locations in a separate

[ Post ] [ Invoice.... ] [ History. .. ]
Gty. On Hand  Gty. On Sales Order  Qty. On Purchase Order Qty. Committed Gity. Available

Location 1 (E2) 0 15 [H 80 [E ] 70

All Locations (Ea) 78 23 [8 480 [4 0 78

window. (The image below shows the window widened to display most of the quantity
columns.)

A0
Aoy
Aoy

Click the All Locations button to move the Quantities in front of other windows (if hidden).

The All Locations button appears at the bottom of the Extended PO Receipt Entry screen if

you choose to dsplay quantities on a separate screen.
Item Quantities will be refreshed as you move to other detail lines.

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.
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Extended PO Receipt Entry Displaying Quantities for multiple locations and companies

Selecting which companies and locations are displayed

An administrator must first set up the Sage 300 company databases and locations that are displayed in
the ltem Quantities grid.

e Goto TaiRox Productivity Tools > Options, and click the ltem Quantities tab.

PTDEMO - Options

File Help
Menu  ttem Quantities
Database ID | Description User ID Password Location
SAMLTD Sample Company Limited sa pass1234 1
SAMINC Sample Company Inc. =3 pass1234 1
SAMINC Sample Company Inc. sa pass1234 2
SAMLTD Sample Compary Limited =3 pass 1234 2
PTOEMQ |~/ Productivity Tools Demao sa
CHKWAN
CPYINC
CPYLTD
PTCOPY
PTDEMO

o Use the Insert and Delete keys to add or remove locations and companies from the Iltem
Quantities grid and to change the order that locations appear.

Each user can customize the item quantities grid by hiding and moving columns to suit their own needs.

For example:

e You can hide the Database ID and Name columns if all locations are in the same Sage 300
company.

e You can also hide the Item Description and Stocking Unit if these are the same at all locations.
Hide and re-arrange columns by dragging and dropping.

PTDEMO - Item Quantities

File  Help
Location | Description ftem Number Gity. On Hand | Gty. On Hand (Al)
Central warehou... 0

2 Portland Office A1-105/0 143 378 1] 8 143 1} 135 |
3 Newark, New Je... A1-105/0 7 378 150 ] 75 [1} 75
4 Port of Vancouver  A1-105/0 50 378 250 0 50 0 %0 -
4| [ 2

e

TaiRox Productivity Tools for Sage 300 15
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Extended PO Receipt Entry Using the Extended Drop Ship window

Using the Extended Drop Ship window

The Extended Entry Drop Ship window lets you drop ship multiple items at a time.

Click the Drop Ship button to display the Drop Ship pop up window.

e The top portion of the form is the same as the standard Drop Ship form.

e The grid at the bottom displays the Purchase detail lines.

' PTDEMO - Drop Ship =0 =R

File Help

Set Drop Shipment Addressto  Customer Ship-To Address -

[ CustomerNumber _|[1200 Q

Ship-To Location [WAREHS -"\

Descrigtion |Warehuuse

[Wabash Industial Fark

|
| |
Ciy [Wabash | State [ |
st — |
Phone Number |‘: ) - | Faze Mumber ‘l ) - ‘

Location Emai | |

|
Address [Receiving Dock 17 |
|
|

Contact [ |
Contact Phone |‘: ) - |
Contact Fax |\' ) - |

Contact E-mail

Mo 1 D1-608/B Double Pedestal 7inX.. 1 Yes 1
e o 57 Kuga 250 Am Theerg 11 Jvm | 1]
No 3 C2-230/G 2300 Series Posture Chair 1 Yes 1
No 4 D2613/8 Single Pedestal 60in X 3... 1 Yes 1
No 5 F1-265/B Filng Cabinet - 2 Drawers 1 Yes 2
4 n | 3

[ SelectAl ][ SelectMone |[  DropShip Caneel

To drop ship items:
e Click the Drop Ship button to display the Drop Ship form.

Choose the first drop ship address and items
e Pick a shipment address.

e Double-click the Include column (select “Yes”) for each item that you want to drop ship to the
selected address.

e Click the Drop Ship button on the form to update the PO Receipt Entry window with the selected
items.

Choose the second drop ship address and items

e Select another shipment address to drop ship other items on the receipt to a different location.

e Double-click the Include column (select “Yes”) for each item that you want to drop ship to the new
address.

e Click the Drop Ship button on the form to update the PO Receipt Entry window with the selected
items.

e Press Cancel when done to return to the main PO Receipt Entry window.

TaiRox Productivity Tools for Sage 300 16
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Extended PO Receipt Entry

Receive in Sorted Order

Receive in Sorted Order functionality is most useful when a large PO is being received and the packing

slip is not sorted by PO line number.

Receive in Sorted Order

Press the Receive button to pop up a window to display items sorted in a different order.

You can specify three levels of sort order. Sort order choices are by Line Number, ltem Number,
Vendor Item Number, Item Description, Quantity Received, Received to Date, and Quantity

Outstanding.

Received items can be entered on this form using a time-saving “enter-tab-enter-tab-...”

sequence.

File Help
Order By
Select Order By

% PTDEMO - Receive

ltem Mumber

=]

(Mone)
Line
ltem Mumber

ltem Description

endor ftem Number

=N NoN )

Load

GQuantity Received Quartity Receiv... | Unit of Meas... | Recsivedto Date | Quantity Outstandi...

Received to Date

Quantity Outstanding 3 25 Ea. [1] [1]
5 F1-265/T Filing Cabinet - 2 Drawers 3 25 Ea. 0 0
4 F1-270/T Filing Cabinet - 2 Drawers - Hunts-2500 3 151 Ea: 0 10
3 F1-465/B Filing Cabinet - 4 Drawers £} 25 Ea. 0 0
2 F1-465/T Filing Cabinet - 4 Drawers 3 3 Ea. 0 0
1 F1470/T Filing Cabinet - 4 Drawers - Hunts-2500 3 & Ea. 0 15

< 1 | +

Gty. On Hand  Gty. On Sales Order  Qty. On Purchase Order Qty. Committed Gty. Available
Location 3 (Ea.) 0 o[e 75 [2 0 0
All Locations (Ea.) 0 4 [H 75 [4 0 0
Close

TaiRox Productivity Tools for Sage 300
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Extended PO Receipt Entry Quick PJC Entry

Quick PJC Entry

To speed up data entry, Extended PO Receipt Entry will default inserted lines to the previous entry's
selections for Contract, Project and Category when multiple lines use the same selections.

The following form shows how the order form appears immediately after pressing the Insert key to create
the second line (with default values for the Contract, Project, Category and Cost Class fields):

PTDEMO - Extended PO Receipt Entry

File  Help P/O Receipt Entry

i) 14 4 T~ PHaE s [ e
Vendor Number ), B |M0dem Design Ltd |

Receipt Taxes Addiional Costs  Optional Fields  Totals

PO Number ] | | ‘-’-‘i From Muttiple POs Job Related [ Retainage No. of Receipts Dl
Receipt Date 01/10/2020 Posting Date [pr/10/2020 | [2020-01 | Lot Receipt No. | |
Template [ ] oefowcaton [ |Q B SpTolocaten | | bl
FOB Point | | ShipVa | 12| |
Tems Code ™ |DUETEL | Q |Due by Invoice Date |
Vendor Acct. et = |[OTHER | Q |.‘\ccounts Payable. Other |
Description | | Reference ‘ |

Completes ... | @, Contract Q, Project Q, Category Cost Class Q, ltem Number ltem Description
No 120-1200-10 1003 MGTLABOR Labor 100060 Frye. Donald Wiliam
[No [ 120-1200-10 MGTLABOR lebor [ [ [ |

4 | [ |

Receive Al [ ttem Finder. ] [ Drop Ship. ] [ Beceive Receipt Subtotal D-DD| |C-AD |

[ Pogt ] [ Invoice... ] [ History... ]
Cty. On Hand  Qty. On Sales Order  Giy. On Purchase Order Qty. Committed City. Available
Location a o a 0 o
All Locations a L] a 0 L]
TaiRox Productivity Tools for Sage 300 18
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